
 

Start to Finish with Autodesk® Infrastructure Design 
Suite: A Case Study 
Donnie Gladfelter - CADD Microsystems 
Marissa Gagné - CADD Microsystems 
AC2507 Learn to harness the collective power of Autodesk Infrastructure Design Suite by applying 
Autodesk® Map 3D®, Autodesk® AutoCAD® Civil 3D®, and Autodesk® InfraWorks™ software, as well 
as Autodesk® 360 cloud services in concert through a real-world case study of a road revitalization and 
walkability project. In addition to software interoperability, workflows highlighted in this class include 
identifying land acquisition requirements, establishing and communicating land acquisition values with 
stakeholders, generating and analyzing conceptual proposals in the context of existing conditions, 
finalizing engineering design, and creating immersive online models for the public and project 
stakeholders to interact with. In summary, this class demonstrates the concept that “there’s always 
money in the BANANA (build absolutely nothing anywhere near anything) stand” when stakeholders are 
engaged by your proposals. 

Learning Objectives 
At the end of this class, you will be able to: 

• Analyze project impacts and generate citizen mailing lists from geospatial sources 

• Evaluate and communicate design proposals in the context of a project’s surroundings 

• Generate immersive 3D models to communicate design proposals in the context of the project’s 
surroundings 

• Share interactive project models with key stakeholders and the public online 

 

About the Speakers 
Donnie Gladfelter is a highly visible and respected thought leader in the CAD community. He is well 
known for the CAD Geek blog (www.thecadgeek.com), has written many articles for the popular 
AUGIWorld magazine, and is a popular speaker at Autodesk University and other industry events. He 
has worked with the development team at Autodesk to help shape future versions of AutoCAD, and the 
company has featured him on many occasions, including in numerous video interviews. Donnie also 
helps empower CAD professionals locally and across the world as a Business Development Manager for 
CADD Microsystems (an Autodesk Platinum Partner) and as a former member of the Autodesk User 
Group International Board of Directors.  
 
Marissa Gagné is the Civil & Technical Support Manager and the Civil Team Lead for CADD 
Microsystems.  Marissa graduated from Virginia Tech with Bachelor's and Master's degrees in Civil 
Engineering.  She has been work ing with Autodesk products for almost 20 years, specializing in the Civil 
and GIS solutions.  She has worked for a number of reputable engineering firms in Virginia providing 
CAD support to transportation, utility, land development, mapping, and GIS projects. At CADD 
Microsystems, Marissa's responsibilities include managing the Technical Support department  and the 
Civil Team, performing product demonstrations, teaching classes, giving seminars and workshops, and 
performing consulting for many Autodesk products such as Civil 3D, Land Desktop, Map 3D and Raster 
Design. 
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Introduction 
The project for this study is centered around a proposed road rehabilitation in Richmond, VA.  The 
proposal is for an urban minor arterial connecting two highways that is a popular thoroughfare for 
pedestrians and cyclists accessing nearby trails.  Currently, this is predominantly an undivided, four-lane 
road with limited sidewalks, limited crosswalks, and no service for cyclists.   

The proposed solution for rehabilitation is to expand the road to a four-lane, divided highway with bike 
lanes and 4’ sidewalks on both sides.  This session will explore how this project can be taken from 
conceptual design and visualization through detailed design and construction document creation using 
the powerful tools in the Infrastructure Design Suite.   

Data Sources 
All of the data used in this case study originated from publicly available geospatial data.   Specifically, the 
GIS information was downloaded from the City of Richmond’s Geographic Information Systems website.  
The imagery was acquired from USDA NAIP (National Agriculture Imagery Program) data sources.  In 
general, publicly available data can be accessed from the following resources: 

• Local municipality websites 
• Autodesk InfraWorks Market (http://infraworks-market.weogeo.com) 
• USGS National Map (http://www.nationalmap.gov) 
• GeoCommunity’s GIS Data Depot (http://gisdatadepot.com) 

Step 1 – Project Location and Impact Analysis with Autodesk Map 3D 
The first step in our project involves the analysis of the areas surrounding the road widening project to 
determine if there is a need for additional land acquisition.  This is performed using Map 3D’s GIS 
capabilities to incorporate county and city mapping data into the AutoCAD drawing environment and 
perform analysis.  For this case, Map 3D’s FDO functionality will be employed to access an Autodesk 
SDF file of the project area along with ESRI Shapefiles containing road centerlines, parcel boundaries 
and address information.  Once this data is added to the drawing, a Buffer analysis will be performed to 
discover which parcels will be effected by the road expansion.  Once this is complete, Map 3D’s ability to 
join tables will be used to generate a citizen mailing list for all necessary land acquisition areas.  Below 
are the steps to accomplish this. 

Project Location 
1. Open a basemap drawing and assign the appropriate coordinate system. 
2. Access the Data Connect tool (‘Home’ tab > ‘Data’ panel > ‘Connect’) 

 

http://infraworks-market.weogeo.com/
http://www.nationalmap.gov/
http://gisdatadepot.com/
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3. Use Data Connect to bring in the SDF File for the project area. 

 
4. Use Data Connect to insert the SHP file for the roads, using “Add to Map with Query” to limit the 

insertion to the area to the project extents. 

 
5. Repeat Step 4 to bring in the SHP files for the Parcels and the Addresses 

 
6. Use the Style tools to change the color, linetype, symbol, etc. of the data as desired. 

Project Impact Analysis 
1. Open the Buffer Analysis tool (‘Analyze’ > ‘Feature’ > ‘Feature Buffer’) 
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Note:  The Analyze tab of the Ribbon has another tool called ‘Object Buffer’.  This is used to 
create buffers around topologies 
 

2. Create a 50’ buffer around the centerline of the 
road section that is going to be expanded.  In this 
example, the centerline consists of multiple 
segments.  To ensure the analysis works 
correctly, make sure to choose the “Merge all 
buffers” option at the bottom of the dialog.  The 
50’ will be applied on both sides of the centerline 
down the length of the chosen segments to create 
a buffer with a total width of 100’.  An SDF files is 
created from the buffer, and it is automatically 
inserted into the drawing and added to the Display 
Manager as a new layer.   
 

3. The buffer can now be overlaid across the parcels 
surrounding the centerline to determine what 
areas, if any, will be effected by the road 
expansion.  To perform the overlay, open the 
Feature Overlay tool, which is located directly to the right of the Feature Buffer tool in ‘Analyze’ 
tab of the ribbon. 

4. Create an “Intersect” overlay using the Parcels as the source and the 50’ ROW layer as the 
overlay.  This will create and insert a new SDF file that contains polygons for the areas where the 
50’ ROW intersects the surrounding parcels.  Each polygon in the SDF file contains the 
information from both the Parcel table and the Buffer table. 

 

Citizen Mailing List Creation 
In this example, the Parcels table contains the ID for each parcel, along with additional area.  As 
mentioned above, the overlay process populates the table for the new areas with all of the information 
from their original parcels.  The addresses for the parcel owners are contained in the table for the 
Address Points shapefile, which also contains the Parcel ID.  In order to pull the necessary information for 
the mailing list, both tables must be referenced.  Since both of these tables contain a matching unique 
identifier (Parcel ID), they can be joined together. 
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1. Open the table for the new layer 
that was created by the Overlay 
process, and select the “Join” 
command from the ‘Options’ 
button at the bottom of the table 
dialog. 
Note:  This function will be greyed 
out if there are checked-out 
features. 
 

2. Create a One-to-One relationship between this table and the Address Points table using the 
Parcel ID as the matching column.  

The result of the join is a single table showing the IDs, owner names and addresses for all of the 
effected Parcels.  This table can be exported to a CSV file which can be used in a variety of programs 
such as Excel and Word to create the mailing list.  

Note:  The Export function is found in the same location as the “Join” function.  You must select one 
or more rows in the table for this function to become active.  
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Conceptual Design Evaluation and Communication 
With the preliminary planning studies complete, Autodesk InfraWorks is used to facilitate the exploration 
and communication of the conceptual design. The first step in this process is to establish context for the 
proposed road design by modeling existing conditions. Historically, existing conditions models have been 
limited to a very narrow focus area. As this case study will demonstrate, InfraWorks is able to construct 
3D models from 2D source data very efficiently. 

Building an Existing Conditions Model  
Autodesk InfraWorks uses the same Feature Data Object (FDO) providers employed by Autodesk 
AutoCAD Map 3D. This means the same geospatial data used to complete the preliminary planning 
studies will also be used for the exploration of conceptual designs. Autodesk InfraWorks 2014 can import 
the following data types: 

• 3D Models: FBX, IMX, 3DS, OBJ, DAE, 
and DXF files 

• AutoCAD DWG: 2D and 3D DWG files 
• Autodesk IMX: Data exchange format 

between Autodesk InfraWorks and 
AutoCAD Civil 3D 

• CityGML: GML and XML files. 
• LandXML: XML files that are easily 

exported from most civil engineering 
applications. 

• Point Cloud: RCS and RCP files created 
with Autodesk ReCap. 

• Raster: Any common image format 
including MrSID. 

• Revit RVT: Autodesk Revit models 
(requires Autodesk Revit to be installed) 

• SDF: Autodesk geospatial file created 
with Autodesk AutoCAD Map 3D. 

• SHP: Standard geospatial format for 
ESRI applications. 

• SQLite: Microsoft SQL database that 
does new require a server to function. 

Importing Autodesk AutoCAD Civil 3D Data 
The Autodesk IMX format is a purpose-built to exchange data between AutoCAD Civil 3D and Autodesk 
InfraWorks.  

1. Import the IMX file exported from Civil 3D using the Add File Data Source tool on the Data 
Sources panel. If the Data Sources panel is not already open, click the Data Sources tool on the 
Import panel of the Home Ribbon tab. 

2. Select the connected IMX file, and use the Configure Data Source tool on the Data Sources 
panel. 
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3. The IMX file could contain any number of elements exported from Civil 3D. The IMX tab will list 
everything contained within the IMX file, only the necessary items to be imported. 

 
4. After selecting the items for import, click Close and Refresh to return to the model where the 

selected items will display. 

 

Importing and Classifying Geospatial Data 
Autodesk InfraWorks can import both ESRI (SHP) and Autodesk (SDF) geospatial data. Although these 
are 2D file formats, InfraWorks will generate 3D models of the information through its built-in data 
classification system. Data may be classified as barriers, buildings, city furniture, coverage areas, 
intersections, pipeline connectors, pipelines, points of interest, railways, roads, terrain, trees, or water 
areas. Similar to the concepts of style applied within AutoCAD Civil 3D, the appearance for each of these 
classifications is controlled through a series of styles. 

1. With the Data Sources panel open, click the Add File Data Source tool to connect to the GIS data 
for the project. Although both ERSI SHP and Autodesk SDF files are separate options on the Add 
File Data Source menu, both can be used to build InfraWorks models. 
 
Tip: Dragging-and-dropping data from Windows Explorer into the Data Sources panel within 
InfraWorks will add the dropped data to an InfraWorks model. 
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2. To begin assigning a Feature Type Classification, select on its name from the Data Sources 
panel, and click the Configure Data Source button.  
 
Since GIS data can represent any number of features, InfraWorks assigns newly imported data 
the <No Feature Type> classification, and will not display in the model until a feature 
classification is assigned.  
 

3. Click the Type drop down list from the Data Source Configuration dialog to select an appropriate 
feature classification. 

 
InfraWorks allows data to be classified as any one of the following Types: 

• Barriers 
• Buildings 
• City Furniture 
• Coverage Areas 
• Intersections 
• Pipeline Connectors 
• Pipelines 

• Points of Interest 
• Railways 
• Roads 
• Terrain 
• Trees 
• Water Areas

At this point, clicking Close & Refresh at the bottom of the Data Source Configuration dialog 
will add the selected data to your model; however it’s important to note none of the tabular 
data associated with the data source will appear at this point. 
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4. Although InfraWorks can read any of the tabular data contained within a Data Source, it will not 
provide access to the data unless it’s mapped to one of the standard InfraWorks fields. In this 
example a road centerline SHP file is being configured: 

a. On the Common tab, map the road name (FullName) to the Name property. 

 
b. Switch to the Table tab within the Data Source Configuration dialog, and assign the use 

classification (Functional) to the InfraWorks User Data field. 

 
The Centerlines data source used in the example has a tabular data field that indicates 
the use category of each road. This classification can be used to apply styles to 
roadways in the InfraWorks model. 
 

5. Click Close & Refresh to add the data to the model. 

Classifying each of the Data Sources produces the following InfraWorks model: 
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Importing Aerial Imagery 
InfraWorks can import a vast array of image types including popular formats such as TIF, JPG, and SID. 
Although InfraWorks can technically connect to any supported image, it’s best to use imagery that 
includes a World File. A world file is an ASCII-based file that includes information about the insertion 
point, scale, and rotation of an image. World files typically replace the last letter of the file extension with 
a W; so the world file for a TIF would be TFW, JOG would be JPW, and SID would be SDW. 

Tip: Autodesk AutoCAD Raster Design (included with the Infrastructure Design Suite) can create a world 
file from any image inserted into Autodesk AutoCAD 

 

Procedurally, connecting to imagery is very similar to the procedure employed connecting to GIS data in 
the previous section. To review: 

1. Click the Add File Data Source tool on the Data Sources panel. Select Raster as the source type. 
2. Configure the data classification by clicking the Configure Data Source button. 
3. Select Ground Imagery from the Type drop down list within the Data Source Configuration dialog. 
4. Click Close & Refresh to add the imagery to the InfraWorks model. 

Once connected, the InfraWorks model will include the selected imagery draped over any surface data 
present in the model: 

 

Stylizing Roadways Based on Use Type 
The existing conditions model is nearly complete, although at this point each roadway in the model uses 
the same typical section, or style as it’s known within InfraWorks. Although styles could be revised on 
street-by-street basis, doing so would be incredibly time consuming. For this reason, the Style Rules 
function within InfraWorks is used to apply more appropriate styles based on the documented use type for 
each road in the model. 

In this example, the centerline SHP file contained a tabular data field documenting the use type of each 
road in the city. To make it possible to assign road styles based on use type, the Functional tabular 
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data field was mapped to the InfraWorks User Data field when the Data Source was configured earlier in 
this document. To use this information to assign road styles: 

1. Navigate to the Stylize Model panel of the Home Ribbon tab to open the Style Rules panel within 
InfraWorks. 
 

2. From the Style Rules panel, switch to the Roads palette. 
 

3. Click the + icon to create a new Rule, and provide a name for the Rule from the Add Style Rule 
dialog that opens. 

 
4. Select the newly created Rule, and then click the pencil icon to begin authoring its definition. 

 
 

5. Click the Edit (pencil) button within the Expression section of the Rule Editor dialog. 
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6. AutoCAD Map 3D and InfraWorks share the same Create Filter Expression dialog. The core 
difference between AutoCAD Map 3D and InfraWorks is that AutoCAD Map 3D expressions will 
query the tabular data fields within the connected data, whereas InfraWorks expressions will 
query the InfraWorks properties. To build a Style Rule Expression: 

 
a. Click the Property button from the toolbar and select USER_DATA. 
b. Click the = button from the toolbar. 
c. Click the Get Values button on the right side of the dialog. 
d. Click the green arrow pointing to the right to display a list of unique values for the 

selected field. 
e. Double-click the value representing the road use type to insert it into the expression. 
f. Click OK to save the expression and close the Create Filter Expression dialog. 

 
7. From the Style Editor dialog, click the + icon within the Styles section to add a style definition to 

the rule. 
 

8. Select a Road style for the Style Rule, and click OK. 
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9. A single rule may contain multiple Road styles; 

InfraWorks will randomly assign these styles to 
any feature matching the rule. Click OK to save 
the Rule.  

10.  Repeat steps 3-9 to configure each use type. 
 
A separate rule must be created for each road 
use type. 

 
 

11.  After configuring rules for each use type, click 
the Commit icon on the Style Rules panel. 
 

12.  Click the Refresh (green play) button to apply the Style Rules to the model. Once complete, 
different styles are applied to each road use classification: 
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 Building the Proposed Model 

Create a New Proposal 
Allowing multiple design concepts to be explored, InfraWorks allows any number of proposals to be 
created. When creating a new proposal, InfraWorks will take a snapshot of the current proposal, allowing 
the copy to be modified. By default, every InfraWorks model includes a proposal named Master. To keep 
an unaltered copy of the existing conditions intact, a new proposal is created before beginning the 
conceptual design process. 

To create a new proposal: 

 

1. Open the Proposals palette from the Design panel on the Home Ribbon tab. 
 

2. From the Proposals palette, select the existing proposal to use as a baseline, and click the + 
button to begin creating a new proposal. 
 

3. Enter a name for the proposal from the Add New Proposal dialog, and click OK. 

 
 
Note: Since InfraWorks is based on a SQL database, proposal names cannot include spaces. 
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Authoring a Proposed Road Style (Typical Section) 

 

Similar to AutoCAD Civil 3D, InfraWorks harnesses a collection of styles to control the appearance of 
model elements. Although InfraWorks includes a vast collection of styles out-of-the box, additional styles 
are easily created within its style authoring environment. In this example, a custom Road Style is 
necessary to apply the typical section illustrated above to the conceptual model that will be authored. 

To create a custom Road Style: 

1. Click the Style Palette button on the Stylize Model panel of the Home Ribbon tab. 
 

2. If it’s not already current, switch to the Road tab. 
 

3. Although new styles may be created from scratch, it’s often easier to copy and then customize an 
existing style. Select a Road Style, and then click the Make A Local Copy button to make a 
duplicate style and provide a new name for the style. 
 

4. Select the newly duplicated style, and then click the Pencil icon to begin customizing it. 
 

5. Customize the components within the Track Settings section to match the design parameters for 
he projects typical section. 
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6. Trees and other site elements, known as Decorations, may be added after specifying the typical 
section design parameters. Click the fire hydrant icon to begin adding site elements to the Road 
Style.  
 

7. Destination Targets correspond to each of the typical section elements. The decorations for each 
are controlled by selecting the typical section element from the Decoration Target drop down list. 

 
 

8. Click the + icon to begin adding Decorations to each part (medians, lanes, etc) of the typical 
section. 
 

9. Browse to the desired style category to select a decoration to add to the Road Style. Click OK. 

 
. 

10.  Once added, each the placement of each Decoration is adjusted within the Decoration Settings 
section of the Decoration Editor dialog. 
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11.  Repeat steps 7-10 to compose the final Road Style for the specified typical section. When 
finished, click Close to return to the Configure Street dialog. The completed Road Style for this 
case study: 

 

Defining a New Alignment 
Due to the wider typical section, Forest Hill must be realigned in some areas. Although alignments may 
be imported from AutoCAD Civil 3D, it is also possible to author alignments directly within the InfraWorks 
environment. To accomplish this, the existing alignment must be removed, and then the revised 
alignment will be sketched directly into the model. 

1. Select the existing alignment, pressing the Ctrl key to select multiple elements at once. Press the 
Delete key to remove the selected elements from the model. 

 
 

2. Click the Create/Edit Features button from the Tool Strip to access the tools for creating the new 
alignment for Forest Hill Ave.  
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3. Select Roads > Design Roads [Arterial] from the Create/Edit Features toolbar. 

 
Note: The road design tools are only available within InfraWorks Ultimate and InfraWorks 360. 
 

4. Use the sketching tools to author an initial horizontal alignment within InfraWorks; the sketching 
tools will allow you to place PI points, and will automatically insert curves between tangents. 
Double-click to complete the alignment. 
 

5.  Drag-and-drop the custom Road Style onto the newly created alignment so the wider section 
may be considered. 
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6. With the proposed Road Style/typical section applied, select on the alignment to reveal its PI 
points, adjusting its horizontal location by: 

a. If curves instead of spirals are preferred, right-click on the PI marker and choose Curve. 

  
b. Taking existing structures and other design constraints into account, adjust the incoming 

tangents by selecting on the PI marker, and moving it to the desired location. 

 
c. Finally, adjust the curve radius using the curve slider found by right-clicking on the PI 

marker and selecting Edit Curve. 
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Creating an Optimized Finished Grade Profile 
Roads sketched within InfraWorks are inherently three-dimensional, and for that reason both horizontal 
and vertical elevations were created as the proposed alignment was sketched into the model. This 
arbitrary profile may be adjusted manually; however InfraWorks’ integration with Autodesk 360 can 
automatically create a cost-optimized profile. 

Note:  Profile optimization within InfraWorks consumes 100 cloud credits with each 5 km (approx. 3 miles) 
of road. 

To optimize the arbitrary profile using Autodesk 360: 

1. Adjust the costs that will be used to 
optimize the profile by selecting 
Construction & Earthwork Costs from the 
Corridors panel of the Optimize Ribbon 
tab.  
 

2. Industry average cost data is built into 
InfraWorks, however design teams can 
override this data with project-specific 
cost data from the Construction & 
Earthwork Costs Settings dialog.   
 

3. Select the Vertical Optimization button 
from the Corridors panel of the Optimize 
Ribbon tab.  
 

4. Select the proposed alignment from the 
InfraWorks model, and then expand the 
Advanced Settings section of the Corridor 
Vertical Optimization palette. 
 

 

 

The Advanced Setting section of the 
Corridor Vertical Optimization palette 
allows design parameters such as the 
minimum grade, and frequency for PVI 
stations to be established. 
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5. Once the design parameters are specified, the design may be 

submitted to Autodesk 360 for 
optimization by selecting the 
Optimize It button within the Corridor 
Vertical Optimization palette. 
 
InfraWorks will upload the selected 
alignment to Autodesk 360 for 
optimization. 
 

6. Once submitted, Autodesk 360 
Profile Optimization jobs may be 
monitored by selecting the Job 
Status tool from the Corridors panel 
of the Optimize Ribbon tab. Once complete, Autodesk 360 will send a notification email with an 
alignment report (PDF), and optimized profile (IMX) that may be imported into either InfraWorks 
or Civil 3D. Both files are also available for download within the InfraWorks envoronment by 
naviating to the Job Status palette. 

Visualizing Proposed Design Concepts 
Once completed, design concepts may be presented to stakeholders in a number of ways including both 
animated flyovers and still images. Animated flyover sequences authored within InfraWorks are easily 
distributed to stakeholders; not only as videos, but also interactive sequences delivered through a web 
browser using Autodesk 360. 

Creating a Flyover Animation 
Using a collection of standard camera movements, flyover sequences are only limited by your 
imagination. Beyond that catalog of camera movements, InfraWorks can automatically create animated 
flyover sequences from Design Roads (what was used for the proposed road realignment). The following 
workflow outlines the steps required to accomplish this: 

1. Animation sequences are contained within Storyboards which may be accessed by selecting 
Storyboards from the Storytelling panel on the Present Ribbon tab.  
 

2. To create a new Camera Path, select the proposed alignment from the InfraWorks model, and 
then choose the Camera Path > Create from Design Road 

 
 

3. By default, the Create from Design Road tool will create a fly through along the centerline of the 
selected alignment. Since  the proposed road features a divided median, the default animation 
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will collide with the trees and streetlights positioned within the median. This can be corrected by 
modifying the key frames generated by InfraWorks:  

a. Right-click on a key frame for the generated storyboard, and select Go to location. 

 
b. Use the mouse to position the camera to a location that tracks along one of the travel 

lanes. To elevate the camera, use the Elevate Camera tool located on the View Ribbon 
tab > Navigate panel. 

c. Once the camera position has been updated, select the Reset button on the key frame 
properties area within the Storyboard palate. 
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Publishing Animation Sequences 
Animation sequences are assembled for 
publishing using the Scenarios functionality 
within InfraWorks. Scenarios may contain any 
number of Storyboard sequences from any 
number of Proposals included within a model. 

1. Open the Scenarios palette from the 
Storytelling panel on the Present Ribbon 
tab within InfraWorks.  
 

2. Select the + button to create a new 
Scenario. 
 

3. Each scenario consists of a number of 
parameters which includes what part of 
the model to include (Area of Interest), 
which Storyboards to include, and the 
resolution/level of detail that will be used 
when publishing the model online. 
 

4. Once configured, publish the selected 
scenario to Autodesk InfraWorks 360 
button located in the bottom-left corner of 
the Create Scenario dialog.  
 

5. InfraWorks will then upload the model to 
Autodesk 360. Once published, 
InfraWorks will provide a link that may be 
shared privately, or publically with 
stakeholders to solicit their input abou t 
the proposed project. 
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Export Proposal to AutoCAD Civil 3D  
Autodesk InfraWorks is intended as a conceptual design exploration tool best used in the 0% - 35% 
phase of a typical project. With this in mind, AutoCAD Civil 3D remains the tool best suited for detailed 
design and documentation. Similar to the inflow of data from Civil 3D to InfraWorks when creating the 
existing conditions model, information created and/or 
altered within InfraWorks can be sent to Civil 3D using the 
same IMX file format. 

When exporting an InfraWorks model to Civil 3D, it’s 
important to note the IMX file will contain all design 
elements such as terrain and centerlines visible within the 
current Proposal. To create an IMX export from 
InfraWorks: 

1. Navigate to the Application Menu > Export, and 
select the Export IMX tool.  
 

2. Keeping in mind the IMX export will, by default, include all visible entities, it’s ofentimes helpful to 
limit the export region by defining an Export Extent from the Export to IMX dialog. 

 
 

3. Although Civil 3D can perform coordinate conversion on the fly, it’s best to create IMX exports in 
the same coordinate system as the Civil 3D design. Regardless of the InfraWorks model 
coordinate system, the Export to IMX dialog allows a coordinate system to be specified for the 
export itself. 

 
 

4. Finally, choose a location to save the IMX file, and click Export to create the IMX file. 
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Detailed Design Model Creation and Documentation 
Once a conceptual design has been accepted, it can move on the detailed design phase.  This is the 
phase where Civil 3D’s powerful, dynamic modeling tools come in handy.  While these tools can be used 
to quickly create design Alignments and Profiles from scratch, Civil 3D can also use the conceptual 
design information from Infraworks that was created in the previous step.  Infraworks has the capability to 
export Surface data, water areas, and the Alignments and design Profiles for road proposals to and IMX 
file.  This IMX file can then be imported into Civil 3D and used as the basis for the detailed design phase.  
The steps to accomplish these tasks are described below: 

Import the IMX File 
1. Open the Import IMX Tool (‘Insert’ tab > ‘Import’ > ‘Import IMX’) 

 
2. Choose the IMX file that was exported from Infraworks.  Surfaces will be generated from each 

exported terrain and alignments with design profiles are created in the drawing based on the road 
proposals.  
Note:  No Surface Profile is created for the Alignment during the Import process.  This Profile will 
need to be generated in Civil 3D using the “Create Surface profile” command.  

a. The Alignments are placed in a Site, 
so they will be found under the “Sites” 
category in the Prospector.  When 
these Alignments come into the 
drawing, they will be displayed using 
the default Alignment Style and Label 
Set.   

b. Civil 3D Profiles can only be seen in a 
drawing when a Profile View is 
created.  The export/import process 
does not create this Profile View, so 
the design Profile will only appear in the Prospector.  A Profile View can be created using the 
Profile View command under the “Profile and Section Views” panel on the Home tab of the 
ribbon.   
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Complete the Detailed Design 
The Alignment and Profile that originated in InfraWorks can be used as a starting point for the completion 
of the detailed design in Civil 3D.  If it is necessary to maintain the original, conceptual objects, the 
standard AutoCAD “Copy” command can be employed to generate a duplicate Alignment and Profiles 
which can be renamed and edited for the design phase. Once the edits to these objects is complete, a 
dynamic model of the road design can be built using the Assembly and Corridor tools. 

1. Use Civil 3D’s Assemblies and Subassemblies to design the cross section for the proposed 
roadway 

 
2. Create a Corridor Model of the proposed roadway using the Alignment, the design Profile, and 

the Assembly with the Existing Ground as the daylight target. 

 
a. Once the Corridor is generated, any change to the Alignment, Profile, Assembly or 

Existing Surface can automatically update the model.   For this to work, make sure to set 
the Corridor to “Rebuild – Automatic” from the Prospector. 
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Generate Construction Documents 
Once the design is complete, plan sheets, profile sheets, plan and profile sheets, and section sheets can 
be easily generated using Civil 3D’s Plan Production tools.  In order for these automated tools to build 
sheets using the correct size, titleblock, and viewport layout, a template file should be generated that 
contains layout tabs for each sheet size, scale, and use type. Civil 3D comes with a few sample Plan 
Production template files that are located in the same folder as the standard drawing templates.  These 
should be customized with company-standard titleblocks, north arrows, and scale blocks incorporated into 
the necessary sheet sizes and types.  The following steps outline the generation of Plan and Profile 
Sheets with this functionality 

Note:  For the sheets that will hold Plan, Profile, or Section views that are generated automatically by Civil 
3D, the corresponding Viewports must be assigned the correct “Type”, which can be accomplished 
through the Properties palette.    

1. Before Sheets can be created, Civil 3D must use the desired page size, viewport arrangement, 
and scale to figure out how to break down the Alignment into multiple sections for placement on 
the sheets.  To accomplish this, access the View Frame creation command (‘Output’ > ‘Plan 
Production’ > ‘Create View Frames’) 

 

2. Walk through the View Frames wizard to choose the desired Sheet type, the corresponding 
template file, the chosen layout from that template file, and the orientation for the Plan View. 
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3. Sheets can now be generated using the View Ports as the guides.  Start the Sheet creation 
wizard from the ‘Create Sheets’ button right next to the ‘Create View Frames’ button on the 
Ribbon. 
 

 
Note:  The black  areas on the Plan views are “Match Line Masks”.  These can be turned off or 
edited in the Match Line Styles. 
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